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1. Selecting the output from The Grid 
The Grid brings together two types of program: a full screen communication 
system (normally used with symbols) and an on-screen keyboard (normally used 
with text). 

When you select a cell in The Grid, the output (if any) from that cell needs 
somewhere to go.   

1.1. Full Screen with no output 

 

Some grids require no output at all, such as a menu 
grid used to find other grids, or an environment 
control page set up to control the television. 

1.2. Full screen with work area 

Symbol bar 

 

 

Symbol users may create sentences that are 
displayed as a row of symbols in the bar at the top 
of the screen.  For working with longer sentences, 
there is a ‘small symbol’ option, which allows a 
longer sentence to be visible by using smaller 
symbols.   

When a sentence has been completed it can be 
spoken aloud by the speech synthesiser, or printed.  
Sentences may also be corrected. 

Text bar 

Abc

 

Text users may use letters, whole words or complete 
phrases when constructing sentences.  If a symbol is 
selected in text mode, the text for that symbol is 
added to the sentence. 
As well as complete words and phrases, input may 
be speeded up with word banks or prediction. 

Calculator bar 
It is also possible to include a simple calculator in the grid set.  The calculator bar 
appears like the text bar but allows simple calculations to be performed. 
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1.3. On Screen Keyboard mode 

 

The Grid can be used to take control of other 
Windows programs.  In this mode, most other 
Windows programs can be launched and used.  The 
mouse pointer, menus and other Windows functions 
can also be controlled. 

Both symbol and text grids may be used in this 
mode, allowing users of varying levels of literacy to 
access standard text based programs such as a word 
processor or email program. 

1.4. Setting the output 

The initial output is specified for a user in the User Settings, section 5.1.  When 
the program starts, the first grid to be displayed will appear in the default output 
mode. 

Many users will wish to show different grids in different modes.  This is done by 
using a command in the cell, described in  section 10.1. 
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2. Creating and modifying Cells 
The Cell Properties window is the key to changing the setup of The Grid.  To 
bring up the window, right-click1 on any cell on the current grid.  

 
The Cell Properties window 

The primary use of this window is to change the properties of a cell, but this 
window also contains the menus for the other setup options.  The different User 
Settings are described later in the Reference Manual. 

2.1. Quick cell creation 

When editing cells, you may turn any of the following features on or off.  They all 
help to make it as quick as possible to edit cells. 

AutoFind– as words and phrases are typed into the Spoken Text box, the 
AutoFind will look them up and show the related picture if it exists. 

Quick text entry – there are four separate pieces of text used by a cell.  This 
feature copies the Spoken Text to the other three spaces as you type. Usually,  
these text options will be the same. 

Default colours – the colour for different types of cell are selected automatically 
according to the function of the cell.  For example, a cell that jumps to another 
page has a different colour to one that speaks a message.  This removes the need to 
allocate a colour to every cell. 

2.2. Setting the cell text 

There are four different pieces of text associated with a cell, Spoken Text, Text 
Output, the description of the cell, and the caption for the cell.  These may not 
always be the same. 

                                                 
1 If you are using the ‘Speak with right-click’ option for auditory feedback, you will need to hold 
the control key whilst right clicking to open the Cell Properties.  You can also use Ctrl-Alt-E to 
open the Cell Properties. 
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Spoken Text - This is the text that will be spoken when the cell is selected.  If you 
type a message in here it will be spoken using the selected speech synthesiser.  If 
you want to record a message or play a .wav sound file then click on the 
Recording Options button. 

Text Output - The text here will be added to the Text Bar if it is visible, or to 
another program if using The Grid as an on-screen keyboard.  To enter special 
characters, click on the Type Options button. 

The text should usually end in a space to allow another word to be selected 
straight away, without needing to find space.  The AutoText feature adds a space 
automatically.  For details on sending characters such as Enter, see section 8. 

Short description of cell - This is the cell description that appears in the status bar 
(only available in on-screen keyboard mode), and is spoken if Auditory Feedback 
is selected. 

Caption - The text that actually appears in the cell is entered on the right-hand 
side of the window, just above or below the cell picture (depending on your setup 
options). 

2.3. Choosing a picture 

AutoFind Picture 
This button will search for an appropriate picture for the Text Output by looking 
in the AutoFind Picture list.  If there is more than one picture for the current word 
or phrase then clicking on this button again will change to the next picture. 

Browse Picture 
If you want to select a picture file then click on this button to show the image 
browser. 

Capture Picture 
If there is a picture in another program, on a website, in a document, or visible on 
your screen, then you can easily use all or just part of it for this cell.  Click on 
Capture Picture and the Cell Properties window and the current grid will be 
hidden, and a small capture window will be shown. 

 

Make sure that the picture you want to capture is on the screen, and then click the 
Capture button.  When you see a ‘+’ shaped cursor, click and hold the left mouse 
button to drag a selection around the picture.  For the best results this selection 
should be square, or slightly wider than it is tall, as this is the shape of most cells. 

Clear Picture 
If you don’t want a picture and one is selected then click here to remove it. 
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2.4. Other cell properties 

Select a grid to jump to 
If you want to jump to another grid when this cell is selected, you can select it 
from the drop-down list. You can also click on the Jump button.  This will show 
you a complete list of the existing grids, along with options for creating new ones.  
Creating new grids is covered in section 3. 

The first three options in the list are (none), (start grid) and (previous grid).  The 
first option is if you don’t want it to jump anywhere from this cell.  Selecting (start 
grid) will jump to the first grid for this set, and selecting (previous) will go back to 
the previous grid. 

If the grid that you select has a symbol (section 3.2) it will automatically appear as 
the symbol for the cell, although you may change it if you wish.  

Bookmarks are a very useful feature of The Grid.  If you set the bookmark when 
selecting a grid to jump to, the program remembers the name of the grid that you 
are jumping from.  Then, next time you choose a cell that jumps to (previous) it 
will jump back to the bookmarked grid.  This means that you can jump back, even 
after visiting a series of pages.  For example, from your Food page, you could go 
to Breakfast, then to Cereal, and jump right back to Food when choosing jump to 
(previous) on the Cereal page. See section 7.3 for more details of jumps. 

Cell Colour 
The colour for a cell can be determined by what it does when selected.  For 
example, a cell that jumps to another page has a different colour to one that speaks 
a message.   

If you wish to override these colour selections, click on the cell colour button (or 
on the cell preview) to show the colour palette.  If you wish to restore the default 
colour, tick the ‘Use default colour’ box. 

Cell Size 
Cells can be double width, double height or both, making them more prominent 
and doubling the time spent on this cell during a scan.  Note that a large cell will 
obscure neighbouring cells even if they are not blank). 

2.5. Advanced Cell Properties 

Clicking on the ‘Show Advanced Options’ button will reveal the lower part of the 
cell properties window.  Clicking on the button again will hide it. 
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The advanced options of the Cell Properties window. 

2.6. Advanced symbol output options 

These tick boxes allow you to customise the actions that a cell performs when it is 
selected. 

Add to Sentence Add the current cell to a sentence being constructed 

Speak Cell Message Speak the ‘Spoken Text’ for this cell 

Speak Sentence Speak the currently constructed sentence 

Preview Sentence Show the current sentence full screen 

Print Sentence Print the current sentence either to a file or the printer 

Erase Last Erase the last cell selected 

Undelete Last If Erase or Clear was selected this will restore the sentence 

Clear Sentence Clear the current sentence 

2.7. Advanced output options 

Run a program 
If you want to run another program, such as a word processor or email program, 
when the cell is selected, enter the name and location of the program file here, or 
click on this button.  You may then select any program that is installed on your 
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computer.  When you select a program (.exe) file, the icon will automatically 
appear as a picture for the cell, although you may change it if you prefer. 

Commands 
There are a number of commands available for use when outputting to  ‘Other 
Windows Programs’.  Full instructions for using commands are in section 10. 

Environment control 
If you have an environment controller such as a GEWA Prog, then you can use the 
cell to activate it.  Select the command you wish to transmit here.  Instructions for 
using an environment controller are in section 12. 

Quitting The Grid 
/quit Quit The Grid. 

If you want to offer an “Are you sure?” option before quitting, then link to a small 
grid call “Quit”, which has two cells.  These are “No, don’t quit” and “Yes, really 
quit”, and it is the latter of these that has the quit option. 

2.8. Copying, cutting and pasting cells 

Sometimes you may wish to duplicate a cell on more than one grid or move a cell 
from one location to another.  This is easily done by cutting or copying the 
properties of a cell, and pasting them into a new cell. 

The Cut Cell, Copy Cell and Paste Cell options are in the Edit menu of the Cell 
Properties window.   

Fast Editing 
If you are doing a lot of cutting and pasting, you may wish to enable  ‘Fast Edit 
Mode’ from the Edit menu, which will enable ctrl-x, ctrl-c and ctrl-v to activate 
cut, copy and paste respectively. 

Warning!  It is easy to lose cell data when cutting and pasting.  Be careful not to 
paste over an existing useful cell. 
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3. Creating and modifying grids 

3.1. Creating a new grid 

New grids can either be blank or they can be a clone of an existing grid. 

To create a new grid, either select File > New Grid from the menu of the Cell 
Properties window, or click on the Jump button followed the New Grid button.  
You will see the new Grid window appear. 

To make a new grid by copying an existing one, click on the Jump button, 
followed by the Clone Grid button. 

If you are cloning an existing grid you need only enter a name for the new grid.  If 
you are creating a new grid then you will be presented with the New Grid window, 
where you can specify the name, size and picture for the grid.  

 
The New Grid window 

Enter a name for the new grid.  You may also alter the number of cells or the grid 
picture at this time.  (You can also change these later; so don’t worry too much at 
this stage). 

3.2. Editing the settings for a grid 

Click on the Grid Settings button (on the Cell Properties window) to show the 
Grid Settings window. 
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The Grid Settings window 

Grid picture 
Each Grid has a picture associated with it, which is shown on cells that jump to 
that grid.  Use the ‘Clear Grid Picture’ and ‘Change Grid Picture’ buttons to 
change the picture for this grid.  The selected picture is shown in the description 
bar at the top of the window. 

Grid size 
The Rows and Columns settings change the number of cells in the current grid.  
This may be limited for the current user by their maximum grid size (see section 
5.1). 

The Cell ratio option applies only to grids that do not fill the screen, and sets the 
width of a cell relative to its height.  Unless you wish to maximise the visible 
portion of the screen, this is usually set to ‘Fit to screen’, which will adjust the 
ratio to use the full width of the screen.  If you select a ratio of 1:1 then the cell 
will not display text if there is also a picture. 

Automatic Content 
The use of prediction and word banks helps users to type words in fewer 
selections, as discussed in section 8.  Phrase linking can be useful in both symbol 
and text modes, and examples of its use are given in section 11.7. 

If you wish to use prediction and/or word banks then you can choose which part of 
the grid is used to suggest words (shaded cells in the following examples). 

 
Prediction in left hand column 

 
Prediction beneath second row 

 
Prediction beneath third row 

Note that with the first option, prediction in left hand column, an additional 
column is added so that no cells are obscured.  If prediction is selected for the 
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bottom of the grid then all cells in the prediction area will be used for prediction, 
even if they have already been set up for another use. 

The full settings for prediction are given in section 5.5. 

If you choose word banks and prediction then the word bank is used after the first 
letter has been typed, and the prediction is used when further letters are typed.  
Notes on the use of word banks are found in section 8.1. 

If a grid is Self-closing then it will close and the previous grid will appear when a 
selection is made, unless the selection is a cell that jumps to another grid (section 
7.3). 
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4. Choosing a User 
It can often be useful to set up more than one user for The Grid.  Each user profile 
has its own unique settings, so you can have several users with different colour 
schemes, input settings and grid sets as appropriate. 

It may also be useful to set up more than one user profile for the same user – for 
example you may wish to have a symbol based user profile with large type for use 
in conversation and a text-based user profile for use when typing. 

Different users can share grids and grid sets, but do not have to. 

4.1. Changing user 

The Change User menu in the Cell Properties window lists the three most 
recently selected users.  If the user you want to activate is in this list then simply 
select them.  If not then select Current User > More Users… to bring up the 
Select User window. 

 
The Select User window. 

Select the user that you want to use from the list on the left, and click Close. 

4.2. Creating a new user 

Rather than modifying the default settings, it is better to create a new profile for 
each user and modify these.  Open the Select User window (see above) and select 
the user that you wish to copy from the list on the left.  Type the name of the new 
user in the box provided, and click on Copy User.  Your new user will appear in 
the list, so select them and click on Close. 

You can check which user is selected by going to the Current User menu, where 
the current user will be ticked at the top of the list, and other recently selected 
users are listed. 
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5. User Settings 

5.1. User Grid Settings 

The User Grid Settings determine the way that grid are used for the current user. 

To call up the User Grid Settings, select User Settings > User Grid Settings from 
the menu. 

 
The User Grid Settings window. 

The description bar at the top of the window says which user you are adjusting the 
settings for. 

Initial output 
The Grid has a number of different output modes.  You can choose between a 
symbol bar, a text bar or other windows programs for constructing sentences - 
these different output types are discussed in section 1. 

This sets the output that is used when the program first opens the first grid.  The 
output may change while the program is running.  See section 10.1. 

Full screen options 
The Grid can display up to 9 rows of 12 cells, which may be too much for some 
users. For example, the cells could be too small for the user or too many cells may 
be displayed.  Setting the maximum number of rows and columns that can be 
displayed for the current user will prevent other helpers inadvertently creating 
grids that are too complex. 

You can also choose to have the text above or below the picture in the cell.  In 
most cases, the text is placed above the symbol (definitely in the case of a touch 
screen user), but some may prefer it below. 
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On screen keyboard options 
These options are used when grids are not displayed full screen, i.e. when using 
The Grid as input to other programs. 

The height of each cell can be chosen here.  Taller cells are easier to see, but allow 
less of the desktop to be seen.  The width of the cell is determined by the ratio, 
which is chosen for each grid (see section 3.1). 

You can also choose to see a status bar, which will display the description of the 
highlighted cell at the bottom of the grid. 

Text output options 
When typing into the text bar you may wish The Grid to read text automatically.  
You can choose the have The Grid speak after each letter, word or sentence.  You 
can also use a Speak cell to read out the current sentence (see section 7.1). 

You can also choose the height of the text bar here. This is the number of rows 
that it’s height is equivalent to. 

General options 
If the user is using a pointing device you can allow the sentence to be spoken by 
clicking in the sentence bar.  This will work in both text and symbol modes. 

You can also prevent a cell being selected more than three times in a row.  This 
would not normally be used, but in some cases of autism it is useful. 

5.2. Appearance 

This window lets you set the way the cells look.  There are various options 
concerning the colours, text placing, and the way that cells and their pictures are 
spaced on the screen. 

 
 The User Appearance Settings window 
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Clicking the Cell Font button allows you to change the font that appears in the 
cells, so that the typeface, colour and size are comfortable for the user.  The Text 
Bar Font applies to the text bar. 

Increasing the picture size makes the pictures easier to see but reduces the 
remaining space for text within a cell. 

The cell spacing controls the separation of the cells.  A touch screen user may 
wish to increase the dead area between the cells to reduce the change of an 
incorrect selection. 

You can turn off the cell borders completely (as long as you are not using it for 
colours) and choose to have rounded corners for cells.  Rounded corners can 
cause a noticeable flicker on some monitors, and this is accentuated particularly 
when using a mouse or head pointer as the selection changes quickly.  If this 
affects you then use square corners, which are drawn without flicker. 

Grid colours 
To help the user to identify the correct cell easily, the colours of the different types 
of cell can be changed according to what they do.  For example a cell with a 
picture of a television could mean any of the following: 

Message  “Please can I watch TV?” • 

• 

• 

• 

• 

• 

• 

Jump  to my TV message grid 

Turn ON  the TV using my environment controller 

Using different colours helps to differentiate between these meanings. 

You can choose to colour the cell border instead of the cell, by ticking the Colour 
border instead of cell box.  In this case you can specify the colour for the inside 
of the cell with the ‘Cell Interior’ property. 

Remember that the cell colours are easily overridden if you intend to use them for 
another purpose. 

Maximising the visible text in a cell 
If you need to use a very large font for readability then you may find that the text 
in some cells no longer fits within the cell boundaries.  In this case there are a 
number of things that can be done to help: 

Choose a narrower font, such as Arial Narrow, and try not to avoid bold text. 

Make the cells larger by limiting the number of cells on the screen with the 
maximum rows and maximum columns settings in User Grid Settings. 

If only one or two cells are affected, try shortening the text in those cells. 

Make the images smaller to allow more room for the text, by adjusting the picture 
size slider. 
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Turn Rounded Corners and Show Borders OFF to allow the text maximum space 
in a cell. 

• 

• 

• 

Place the text above the image rather than below; this ensures that the start of the 
phrase is visible, which may make it easier to identify the cell. 

Use Auditory Feedback to provide the user with an audible guide to what is in 
each cell (see page 16). 

5.3. Speech Settings 

The speech output can be configured from the User Settings > Speech Settings 
menu. 

 
The Speech Settings window. 

There are various synthesisers supported by The Grid.  Note that not all of them 
allow control of the speed or pitch. 

Microsoft SAPI Speech 
This is a universal speech system written by Microsoft to allow anyone to write a 
text-to-speech engines for use in a program that supports SAPI.  Microsoft 
provides some of their own voices and additional free voices in various languages 
are included on our CD.  Further voices can be purchased from other companies.  

Technical note:  The Grid uses SAPI 4.0 for compatibility with the majority of 
voices available. 

DECTalk 
The DECTalk text-to-speech engine is built into The Grid as an alternative to the 
SAPI engine.  The quality of speech is superior to the standard Mary and Mike 
SAPI voices, and is especially useful where intelligibility is of the highest priority.  
DECtalk will run while your copy of The Grid is a demo, but once you licence 
The Grid on your computer, you must also licence DECtalk to continue using it. 
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InfoVox 
InfoVox supply high quality software text-to-speech in various languages.  It is 
available in a number of languages.  InfoVox will run while your copy of The 
Grid is a demo, but once you licence The Grid on your computer, you must also 
licence DECtalk to continue using it. 

Technical note:  Both DECtalk and InfoVox are also available as SAPI speech 
systems, but we have implemented embedded versions that work more reliably 
than SAPI, and are cheaper to licence.  This means that our versions of these 
voices may not be available to other programs on your system. 

Dolphin 
The Dolphin speech synthesiser is an external device that attaches to the 
computer’s serial port.  It is included here for compatibility with legacy systems. 

Experiment with different synthesisers, voices, speeds and pitches until you find 
one that is easy to understand.  You can also change the sample phrase to hear 
different text spoken with the Test button. 

5.4. Auditory Feedback 

Auditory feedback provides an additional aid to selecting the correct cell.  When 
scanning automatically it can be useful to have the computer click or beep as the 
selection progresses to help time the switch presses.  Some users may also find it 
useful to have the description of each cell spoken as it is highlighted. 

 
The Auditory Feedback window 

Clicks and beeps 
These are generated using the MIDI sound system, supported by almost all 
computers made in the last five years.  There is a choice of tones, which are 
played up the scale as the scan progresses, or a metronome tick that remains 
uniform during the scan. 

Spoken prompts 
You can choose to use a different speech synthesiser for the auditory scanning.  
Some voices have a slight hesitation whilst they calculate how to speak a sentence, 
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so you may wish to select a faster voice for the prompts.  We particularly 
recommend DECtalk for auditory scanning as it is very fast to respond, and 
remains intelligible when talking quickly. 

You can also choose to speed up the speech to allow the user (who will be used to 
the synthetic speech) to find the correct selection quickly. 

The final option is to mute the left channel.  If you are able to separate the stereo 
audio from the computer, you can set up the right channel for the user and the left 
channel for the person they are speaking to.  This allows the user to use auditory 
scanning without confusing the person they are talking to. 

None 
You do not have to have auditory feedback for scanning. 

Right button preview 
If the user is using a two-button pointing device then you can use the right mouse 
button to hear the description of a cell.  If you do this then you will need to use 
ctrl-right click or the ctrl-alt-E shortcut to edit a cell. 

5.5. Prediction settings 

If you use prediction with text entry then there are a few settings that change the 
way that prediction is used, found in the prediction settings window. 

 
The Prediction Settings window 

Learning new words 
Add new words automatically: If you type a word that is not in the prediction 
dictionary it will be added automatically. 

• 

• 

• 

• 

Check spelling before adding: The spelling of the word will be checked against 
a dictionary, and only correctly spelt words will be added. 

Learn frequency of use: The prediction system will learn how frequently words 
are used, and suggest those words first. 

Learn consecutive word pairs: The prediction system will learn which words are 
used in sequence and suggest a possible word to follow each selection. 
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Minimum length for new words: Words shorter than this length will not be 
added to the prediction dictionary. 

• 

• 

• 

• 

Prediction display 
List alphabetically: The suggestions are listed in alphabetical order. 

List in order of usage: The most commonly used suggestions are listed first. 

Remove ignored words: If a word is suggested and the user ignores the 
suggestion and types another letter then that word will not be suggested again, 
even if it is still a valid suggestion. 

For information on changing the prediction dictionary currently in use, or adding 
or removing words from the dictionary, see dictionaries (below). 

5.6. Dictionaries 

There are a number of files used by The Grid as resources for prediction and other 
uses.  The files selected for the current user can be seen in the Dictionaries 
window, and these can be modified from here. 

 
The Dictionaries window 

The different dictionaries are discussed in detail in section 11. 

The installed languages are listed in the Language sub-menu.  Selecting a different 
language for the current user here will change the language in which The Grid is 
displayed, and change to the dictionary files in the appropriate language folder 
(see section 13.3 if you are interested in the files in the language folder). 

5.7. Choosing a language 

If you have installed more than one language for The Grid, you may select which 
language you wish to use. 

This affects all the text that appears in the menus, windows and buttons.  It also 
selects the available dictionary files such as prediction, spell checker, word banks 
and speech exceptions. 
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The only text that is NOT affected by the choice of language is the text in the grids 
themselves, so you need to ensure that the Grid Set you are using is in the same 
language. 

5.8. Choosing a Grid Set 

The grids are arranged into grid sets for convenience.  In addition to the sets 
provided with The Grid, there are various grid sets (often called Pre-stored 
Vocabularies) commercially available that are designed for a certain need. 

To change the grid set for the current user, select User Settings > Grid Set from 
the menu. 

 
The Grid Set Options window 

The first option is the Grid Set to use. When you change grid set, the jump grid, 
action pictures and automatic cell colours for that set will be loaded. 

The second option is the name of the start grid (or index grid) for that Grid Set.  If 
you wish to change the start grid, you can select a different one here. 

Action pictures for grid sets 
The common actions such as Speak and Previous Grid will appear in many places 
in a Grid Set.  Setting a standard picture saves a lot of work in finding the same 
picture over and again, and also ensures continuity throughout the grids in the set. 

If no picture is selected for the action, cells with that action will display any 
picture that you choose, as explained in section 2.3. 
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6. Input Device 
Whatever the input method used, the settings can have a significant effect on the 
efficiency with which the user can operate the program.   

The Grid includes many advanced settings, especially for switch users, which  
allow fine-tuning to meet the user’s needs.  

What is my input device? 
The input devices are grouped into three categories:  

Pointer • 

• 

• 

Switches 

Keyboard 

See the appropriate section for your input device for details of how to set it up. 

6.1. Pointer input 

The Pointer Input settings are accessed from the menu: Input Device > Mouse 
Settings. 

 
The Pointer Input window. 

The selection method pane on the right allows you to choose how the cell is 
selected once the mouse pointer is over it.  There are four options: 

On press In this mode the cell is selected when the button goes 
down.  This is the usual choice for a mouse pointer. 

On release In this mode the cell is selected when the button goes 
up. This should be used when configuring a touch 
screen. 

Hold button over cell In this mode the button must be held down for a 
specified period of time. If the button is held down for 
less than this period then the click is ignored. This is 
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useful for users with a tremor, who may tap the button 
accidentally. 

Dwell pointer over cell In this mode the button does not need to be pressed. 
The user leaves the pointer resting over the desired cell 
and after a specified period of time the cell will be 
selected.  The dwell mode will be of use to users who 
are unable to use the button on their pointing device, 
for example head-mouse users. 

Further options 
The settings pane on the left contains options to fine-tune the behaviour of some 
of these options. 

Time period to accept mouse clicks specifies the length of time for selecting by 
holding the button or dwelling over a cell. 

• 

• 

• 

• 

Allowed pointer movement for dwell click specifies the limit of movement 
when using dwelling to click in another application.  Larger values allow the user 
to shake the pointer quite a lot whilst selecting with dwell, but reduces the 
accuracy of the click. 

A useful tip:  Setting the movement allowed to zero will ensure that the clicks will 
ONLY occur on the grid, and nowhere else on the screen.  This is an excellent way 
of preventing a user form inadvertently clicking in inappropriate places on the 
screen! 

Beep on accept causes a beep when a dwell selection has been made if the box is 
checked.   

Auto repeat cells If the box is checked then a cell will be selected repeatedly 
whilst the pointer is held over the cell; if it is not checked then the cell will only be 
selected once and the user must move the selection away and back to reselect the 
cell. 
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6.2. Switch Input 

Up to eight switches can be used to control The Grid, but most users will use just 
one or two. 

To open the Switch Settings window, select Input Device > Switch Settings from 
the Cell Properties window. 

 
The Switch Settings window 

Configuring and testing your switches 
First, you need to make sure that your switches are correctly connected to the 
computer, and that The Grid knows how they are connected.  Click on the 
Configure Switches button in the bottom left of the Switch Settings window. 

 
The Switch Configuration window. 
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Serial switches For many years, it has been customary to connect switches to 
your computer through one of your PC’s serial communication 
ports (usually shortened to com ports).  The connector on the 
computer has 9 pins arranged in two rows.  A USB to serial 
adaptor is available. 

Joystick There are two types of joystick connector – a 15-pin joystick 
port (or game port) or USB.  Both are supported. 

Most USB switch adaptors (such as the JoyBox or Crick Switch 
box) are in fact joystick devices. 

Keyboard Select Keyboard if you are using the keyboard to emulate 
switches.  You can choose which key emulates which switch by 
double-clicking on the numbers at the bottom.  The Keyboard 
connects to a round PS/2 socket.  Special keyboards with switch 
inputs or the Don Johnson Switch Box may be used. 

Note that the keyboard input works only in full screen modes. 

USB Switches USB switch connections work by emulating another switch 
connection.  The most common types are USB-Serial 
converters, for which you select Serial switches, and USB 
Joysticks such as the JoyBox and JoyCable.  For these you 
select Joystick. 

Check your switches are working 
When you have your switches connected correctly the eight numbered panels will 
light up as the switches are pressed.  If the panels do not light up then check the 
following: 

Are the switches connected to the computer correctly?  Check all the connections 
are correct and tightly plugged in. 

• 

• 

• 

• 

• 

Is the right connection type selected (serial, joystick or keyboard)?  Remember 
that devices such as the JoyBox act as a joystick, so this option should be selected 
rather than serial switches. 

Is the right com port selected?  (This applies to serial only)  Usually computers 
only have one external com port, com 1, but try com 2 as well. 

Are the switches connected to the right sockets?  Serial switches usually allow 
two switches to be connected, and the JoyBox has sockets for eight fire buttons 
and four directional buttons.  Switches 1-4 should be connected to buttons 1-4 
respectively, and switches 5-8 should be connected to up, down, left and right (in 
that order). 

Are the correct keys configured (keyboard only)?  Try reconfiguring the keys to 
check that they work. 
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If your joystick is not responding properly, click on Control Panel in the Start 
Menu and double click on Game Controllers.  Here you will be able to test your 
joystick and, if necessary, calibrate the movement to ensure that the direction 
switches (5-8) work accurately. 

• 

Switch mode 
The switch mode determines how the user controls the scanning process – i.e. it 
determines what the user must do to start a scan, to continue the scan and to select 
the cell when it is highlighted.  There are 3 switch modes, auto scan, inverted scan, 
and directed scan. 

Auto scan In this mode the user presses the primary switch to start the 
scan.  Cells will then automatically be highlighted in turn.  
The user presses the switch again when the desired cell is 
highlighted. 

Hold to advance In this mode the user holds the primary switch down. When 
the switch is first pressed the scan will start, and the cells 
will be highlighted in turn until the switch is released. Cells 
are accepted with a timeout or a second switch. 

Tap to advance In this mode, the user presses the primary switch to start the 
scan, and presses it repeatedly to advance the highlight. A 
second switch or a timeout must be used to select the cell in 
directed scan mode. 
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Scan method 
The cells can be scanned in different patterns to speed up the selection process.  
Simple scanning is best for beginners, but the other methods allow much faster 
selections to be made. 

Simple scan 

 
In this mode the cells are highlighted one at a 

time, starting in the top left and proceeding along 
each row in turn. 

Row then Column 

 
Each row is highlighted in turn and the user 

selects the desired row when it is highlighted.  
Individual cells in that row are then highlighted in 
turn, and the user then selects one of these cells. 

Column then Row 

 
 Column then Row works in a similar way to Row 
then Column: first the columns are highlighted in 
turn, and then the individual cells of the selected 

column are highlighted. 

Overscan 

 
If Overscan is selected then the highlight rapidly 
highlights the cells in turn.  The user presses the 

switch as the scan arrives at (or passes) the 
desired cell, and the highlight will then proceed 
slowly backward. The user can then select the 

desired cell. 

Block scanning 

 
Checking the Use block scanning on large grids box will enable block scanning on grids with more 

than 7 columns.  When scanning is started, the four quarters of the grid will highlight in turn.  When 
one of these is selected, the chosen scan method will commence within that quarter of the grid. 
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Mapping commands to switches 
The Grid includes a very advanced switch system that provides ways to maximise 
the efficiency with which the user can operate the program.   

Switch one is always the primary switch. This is used to start scanning and to 
make selections.  In most switch modes it is the only required switch. 

If you have more than one switch, switches 2-4 can perform the following 
commands by selecting the appropriate command from the list next to each switch 
number: 

Accept  Accept the currently highlighted row, column, block or cell. • 

• 

• 

Cancel  Cancel the current scan. 

Reverse  Reverse the direction of the current scan. 

Switches 5-8 are always mapped to the direction functions.  These are best used in 
the held down or tap to advance switch modes to move the highlight around the 
grid. 

Repeat with switch 2: You can also use switch 2 to repeat the last selection by 
checking the box.  If the user then selected a cell saying “ha”, pressing switch two 
twice more after the selection would say “ha ha ha”. 

Further options 
Long hold If you only have two switches you can still have the 

functionality of all four switches by using Long holds.  
This relies upon the user being able to control for how 
long they press a switch. 

Check the Use long hold for extra switches to enable long 
holds.  When switch 1 is pressed for longer than the 
minimum long hold time then the function assigned to 
switch 3 will be performed instead.  Similarly a long hold 
on switch 2 will activate switch 4. 

Select on time out The Select on time out function is useful for users with 
only one switch, using held down or tap to advance.  Once 
the user has highlighted the cell they wish to select they 
wait for the timeout selection time and the cell will be 
activated. 

Offer cancel during 
scan 

This offers an option to cancel a scan after each row or 
column. This is very useful when the wrong row or 
column has been selected. The cancel option appears as a 
highlight of the entire grid. 

Switch Timings 
Click on the Show Switch Timings button in the Switch settings window. 
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The Switch Timing window 

There are eight different timings associated with switching. By carefully adjusting 
these times the switching can be made easier for the user.  All switch timings are 
measured in 20ths of a second, i.e. 1 = 1/20 seconds, 5 = 1/4 seconds, 20 = 1 
second and 30 = 11/2 seconds, but in practise the best way to set them is by trying 
different speeds rather than working out how many 20ths of a second are required! 

The first three timings control the speed of the automatic scanning. 

Forward scanning 
interval 

The time spent on each cell when scanning 
automatically. The larger this time is, the slower the 
scan will be. 

First scan interval The delay between the first cell being highlighted 
and subsequent cells being highlighted.  This will 
usually be longer than the forward scanning interval 
to avoid missing the first cell of the scan. 

Backward scanning 
interval 

The delay used when scanning from right to left or 
from bottom to top.  This will usually be larger than 
the forward scan speed, which will have been set to a 
low value. 

The next four timings are related to reacting to switch presses. 

Minimum switch press 
time 

If a user has a tremor or tends to accidentally tap the 
switch then this time can be increased. The Grid will 
ignore switch presses that last less than this duration. 

Minimum wait between 
presses 

Another common problem is that users will 
accidentally press the switch more than once in 
succession. Setting this time to a value larger than 
zero will make The Grid wait after a switch has been 
pressed. Any presses that occur in this time will be 
ignored. 

Minimum long hold time This is the amount of time for which a switch must 
be held for it to count as a long hold.  This should be 
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significantly larger than the minimum switch press 
time.  (Long holds are discussed later in this section).

Timeout selection time This is the length of time for which the highlight 
must be left unmoved for a selection to occur. 

Finally, the maximum number of scans can be changed. 

Maximum number of 
scans 

If no selection has been made after this number of 
scans then the scanning will automatically stop. 

Avoiding flicker 
You may find that scanning automatically makes the screen flicker, which can be 
uncomfortable when viewed for long periods of time.  This happens when 
displaying rounded corners – these can be turned off in the Appearance window 
(see section 5.2). 

6.3. Keyboard input 

The keyboard mode uses the arrow keys to highlight a cell and either space or 
enter to activate that cell.  It only works in full screen modes. 

The Keyboard Input settings are accessed from the menu: Input Device > 
Keyboard Settings. 

 
The Keyboard Settings window. 

There are three options for key input. 

Single presses:  If you select single presses, the arrow keys must be pressed 
repeatedly to move the highlight around.   

• 

• 

• 

Repeat while pressed:  This causes the highlight to move at the repeat rate for as 
long as the arrow keys are pressed. 

Select with dwell:  This allows you to select the cell by waiting once the desired 
cell is highlighted, rather than pressing space or enter. 
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The timings can be adjusted to change the way that The Grid responds to key 
presses: 

Repeat: If Repeat while pressed is selected then this dictates how quickly the 
highlight will move from cell to cell. 

• 

• 

• 

• 

Accept: If a user has a tremor or tends to accidentally tap the keys then this time 
can be increased. The Grid will ignore key presses that last less than this duration. 

Release: Another common problem is that users will accidentally press the key 
more than once in succession. Setting this time to a value larger than zero will 
make The Grid wait after a key has been pressed. Any presses that occur in this 
time will be ignored. 

Select with dwell: If Select with dwell is checked then this is the length of time 
for which the highlight must be left unmoved for the selection to be accepted. 
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7. Designing effective symbol grids 
When using The Grid in symbol output mode, selected cells are added to a 
sentence in the space at the top of the screen.  This can display either symbols and 
text, or just text. 

When constructing (or more likely personalising) a grid set, you will be working 
with a large number of grids, up to 1000 in some cases, which are mostly full of 
vocabulary.  The grids will also contain links to other grids, and at least some of 
the following actions. 

7.1. Symbol actions 

The symbol actions allow the sentence to be manipulated by the user.  Ticking the 
Symbol output boxes, found in the advanced section of the Cell Properties 
window, creates symbol action cells.  See section 2.6 for more on this part of the 
Cell Properties window. 

Some of the common actions can have pictures automatically assigned to them.  
These pictures can be specified for a grid set – see section 5.8 for more details. 

The standard icons are listed here along with the effect the action has.  Also 
included is the effect that the action will have when working with text output. 

  Symbol action Text action 

 
Speak 
Sentence 

Speaks the current 
sentence. 

 

Speaks the current sentence.  
If there is more than one 
sentence then the one with 
the cursor in is spoken. 

 

Erase Erases the last symbol in 
the sentence. 

Erases the last word typed. 

 

Clear Clears the sentence. Clears the text bar. 

 

Undelete Undoes the last erase or clear action. 

 

Preview Displays the whole 
sentence full screen. 

 

 

Print Prints the sentence according to the user’s print options. 
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Home Goes to the home/start page for the current grid set. 

 

Quit Quits The Grid. 

7.2. Using real pictures 

As well as symbols from a library such as Rebus, PCS, Bliss or Pictograms, you 
can use real pictures from virtually any source. 

You can browse for any picture that is saved as a file, but the Capture Picture 
button is even easier.  For this, you do not even need to save the picture first, nor 
do you need to edit it to select just a part of it. 

Anything you can see on the screen can be captured – that includes previews from 
your camera, images on the Internet, or images that you have scanned.  Because 
The Grid makes its own copy of every picture that you choose as a symbol there is 
no need to save pictures before you use them. 

This also means that you can browse a CD of photos or clip art.  Again, because 
The Grid makes its own copy, you can remove the CD after selecting the picture. 

Section 2.3 explains how to assign the picture for a cell. 

7.3. Jumps to other grids 

We have already seen how to make a jump to a new grid (section 2.4), but there 
are some very useful additional settings that can make the grids more powerful 
and easier for the user. 

Pop–up grids 
These allow you to use a grid as a way of expanding the vocabulary, and come 
back automatically to the main grid that you are working on.  There are two ways 
to make a pop-up: 

Self-closing grids:  These are grids that are set to go back to the previous grid as 
soon as you make a selection. This is effectively the same as making every cell 
‘Jump to previous’ but that would be quite time consuming.  An example of this is 
a ‘Colours’ grid.  This can be linked to any number of other grids (clothes, food, 
etc) and when a colour has been selected you are returned to that grid. 

• 

On the Grid Settings window for the self-closing grid (in the example this is the 
Colours grid), check the box marked “Make this grid a self-closing grid”.  When 
this is set, every cell will automatically jump to the previous grid, unless it is 
specifically set to jump to somewhere else. 
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Save bookmark:  Normally, jumping to the previous grid does exactly that: it 
jumps to the grid that you were on before.  However, you may wish to use more 
than one grid in a pop-up.  For example, you may have a link on your Meals grid 
to Curry, and from there to Balti dishes.  Once you have chosen your balti, you 
would want to jump back to the Meals page. 

• 

To set this up you need to tell The Grid to bookmark a page when you jump from 
it.  In the above example, you would edit the jump cell for Curry on the Meals 
grid.  Click on the Jump button (adjacent to the jump page selection) and tick the 
box marked Save Bookmark. 

7.4. Custom colours 

The Grid normally allocates a colour to a cell automatically, depending on its 
actions. 

However, many grid sets use colours for other functions, such as topic, or part of 
speech.  It is easy to select a colour, but you may wish to select custom colours 
that look better than the basic palette that is offered to you. 

After clicking the Cell Colour button, you will see the colour picker with a row of 
additional squares at the bottom.  Right clicking one of these brings up a more 
sophisticated colour picker that allows you to select the exact shade that you want.  
This will then be saved as a custom colour for the current grid set. 

Remember – the custom colours are assigned to the grid set, and you can have up 
to 8 custom colours for EACH grid set.  

7.5. Using symbol grids for typing 

Although symbol grids are traditionally associated with full screen communication 
systems, The Grid allows you to use all your symbol grids as keyboards. 

This is a huge advantage to users with emerging literacy, and is one of the major 
benefits of The Grid. 
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8. Designing effective text grids 
The Grid is probably the most powerful on-screen program available today.  It has 
many features that are used to make the computer faster and easier to control, 
especially with switch input. 

You can write text either to The Grid’s sentence bar (text output mode) or to other 
Windows programs such as Word (on screen keyboard mode). 

If a cell is selected then the type text output for that cell is added to the sentence.  
The user can also use alphabet grids to type words.  To speed up text entry there 
are three tools provided. 

8.1. Rate enhancement 

There are three main ways in which The Grid can accelerate text production 

Word Bars 
These are simply grids with words (or phrases) in them that can be typed with a 
single selection.   

Word Banks 
These are simple lists of words that are added to the grid automatically after the 
first letter of the word has been entered.  Word banks are normally fairly short lists 
of words and they are not added to or altered as the program is used. 

Prediction 
This is the most powerful way to reduce the number of selections needed to create 
text. The prediction will start after the second letter of the word if the grid also has 
a word bank.  Otherwise it starts immediately you start a new word. 

Prediction uses a far larger vocabulary (up to 10,000 words), learns new words as 
you use them and remembers the likelihood of different words being used in 
different circumstances.  

 
Prediction in progress.  The letter ‘h’ has been entered. 

When a grid has BOTH a word bank and prediction, the word bank is used after 
the first letter and the full prediction dictionary is used after subsequent letters.  
For details of altering your prediction and word bank files, refer to section 11. 
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8.2. Automatically switching between tasks 

The Run Program and Jump settings are often used together to make a quick and 
efficient way to switch between different jobs on the computer.  The idea is to 
design a set of grids that make it easy to work with each of your favourite 
programs.  You then create a cell that runs that program and jumps to the 
appropriate grid at the same time.   

Here are some tips for making this work well: 

Command line 
When you have clicked the Run Program button and selected a program, you will 
see the name of the program at the end.  Many programs allow you to add 
additional “command line parameters” to the end.  Here are two examples: 

C:\……\Winword.exe /n 
Loads Word without opening a blank document 

C:\……\Explorer.exe c:\My documents 
Opens an Explorer window in the My Documents folder 

Note that the actual location of files may be different on different computers.   The 
‘......’ represents the location of these files. 

Preventing multiple copies of a program 
If you use the same cell to run a program and to switch to the appropriate grid, you 
need to ensure that the program is not run again and again.  To do this, you put all 
or part of the title text in the Description box when editing the cell. 

For example, all Microsoft Word windows include “Microsoft Word” in the title 
bar.  Edit the short description of the cell to include these words (typed exactly, 
and in the correct case).  Then, when you select the cell, The Grid will check all 
the windows that are currently active in your system to see if there is one with this 
text in the title bar.  If it finds one, it brings it to the top.  If not, it runs the 
program. 

Making best use of the available screen space 
You can also include the /dock command in the cell.  This will make the program 
that you are launching or switching to fit the full width of the screen, and come 
down as far as the top of the on-screen keyboard. 

Substantial programs like Microsoft Word remember where they were last time 
they were used, so this command is not needed.  In any case, if the program takes 
a long time to load, it may be too late for the command to work anyway. 

However, for small programs like NotePad, which appear at a different place 
whenever they are started, this command ensures that you have the largest area 
available for working on your program. 
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8.3. Avoiding controlling the mouse 

When using The Grid to control other programs, using keyboard shortcuts can 
greatly reduce the required number of selections required (as opposed to using the 
mouse).  Many programs contain lists of keyboard shortcuts in the help files, and 
common programs such as Word, Internet Explorer, Outlook Express already have 
grids designed for controlling them. 

Controlling menus, dialogue boxes, web pages etc. 
To see how this works, look at the menu control grid.  This has cells that open the 
Start Menu and the menu for the currently active program.   

Once you have opened your menu, you can use the following commands in cells 
to navigate around and make choices: 

Arrow keys with the Nudge command will scroll through menus or list of files • 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Tab with the Nudge command will scroll around a dialogue box or web page 

Space will click the currently highlighted button 

Enter will click the OK button 

Escape will click the Cancel button 

Using this handful of commands will save a great deal of time  

Selecting and editing text 
Once again, avoid the use of the mouse if at all possible. 

Use the Shift Lock command to hold down the shift key 

Arrow keys with the Nudge command will then select text 

In particular, Ctrl-Shift-Left and Ctrl-Shift-Right will highlight whole words at a 
time 

Use cut (Ctrl-X), copy (Ctrl-C) and paste (Ctrl-V) cells to edit 

Use the /SpeakSel command to speak selected text 

When using The Grid to output to other programs, you may wish to send advanced 
characters or combinations of keystrokes.  These are entered into the Text Output 
box of the Cell Properties window.  Some of these are available by clicking on the 
Type Text button. 

8.4. Shifted characters 

If you want shift, control or alt held with a character then add the following 
symbol before the character:  

Shift + 
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Control ^ 
Alt % 
Enter ~ 

Examples: 

^c control-c 
%fo alt-f, then o 
%(fo) alt-f, alt-o 

8.5. Smart punctuation 

When sending whole words, these are usually followed by a space so that the user 
does not need to select a space character after each word. 

Smart punctuation ‘remembers’ these spaces and removes them so that the user 
can end a sentence without selecting backspace. 

Full stop {.} 
Comma {,} 
Semi colon {;} 
Colon {:} 
Question mark {?} 
Exclamation mark {!} 

If you want normal punctuation, such as a decimal point, simply write the 
character without brackets. 

The Enter key is also smart, as it turns on shift after it is pressed.  To make an 
Enter that does not set shift afterwards, use the /keypress command.(see section 
10.6). 

8.6. Brackets 

Brackets are reserved for sending shifted characters, smart punctuation and 
character codes.  If you want to send a bracket, it must itself be encased in curly 
braces: 

( {(} 
) {)} 
{ {{} 
} {}} 
[ {[} 
] {]} 

8.7. Text input box 

Sometimes, a smart input box can be difficult to input to from an on-screen 
keyboard.  A notable example is the address bar in Internet Explorer. The text 
input box can be useful in many cases to ensure that the text is correct before 
sending it to the application. 
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The text input box appears above the on-screen keyboard and accepts characters 
until you choose Enter.  You must then select a cell with the paste command to 
insert the text to the current program. 

Instructions for the text input box are in section 10.5. 

 

8.8. Special characters 

These characters cannot be typed into the text box, so instead a control code is 
typed in curly brackets. 

Backspace {BACKSPACE} or {BS} or {BKSP} 
Enter {ENTER} or ~ 
+ {+} 
% {%} 
^ {^} 
Tab {TAB} 
Esc {ESC} 
Home {HOME} 
End {END} 
Ins {INSERT} 
Del {DELETE} or {DEL} 
Break {BREAK} 
Help {HELP} 
Print Screen {PRTSC} 
Caps Lock {CAPSLOCK} 
Num Lock {NUMLOCK} 
Scroll Lock {SCROLLLOCK} 
Up Arrow {UP} 
Down Arrow {DOWN} 
Left Arrow {LEFT} 
Right Arrow {RIGHT} 
Page Up {PGUP} 
Page Down {PGDN} 
F1 {F1} 
F2 {F2} 
F3 {F3} 
F4 {F4} 
F5 {F5} 
F6 {F6} 
F7 {F7} 
F8 {F8} 
F9 {F9} 
F10 {F10} 
F11 {F11} 
F12 {F12} 
F13 {F13} 
F14 {F14} 
F15 {F15} 
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F16 {F16} 
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9. Printing 
There are two ways to print from The Grid.  The first is to go to the File > Print… 
menu and choose what to print.  The second is to use a cell with the Print Sentence 
action.  Before doing either of these you will need to specify which printer to use 
and a couple of other settings. 

9.1. Printing grids 

To print a grid as a static communication aid, for records, or as an overlay for a 
communication device, select File > Print from the menu in the Cell Properties 
window to bring up the Print window. 

 
The Print window 

To print the currently displayed grid leave the first option selected and click on 
Print Now.  If you wish to print more than one grid from the current set then select 
the second option and tick the grids you want to print.  You can also print 
sentences that have been saved (see next section). 

9.2. Printing from a grid 

You can choose what happens when a Print Sentence cell is selected (to find out 
how to set up a cell for this, see section 2.6). 

Click on the Print Options and change the setting labelled ‘Print user’s sentences 
to:’ 

• Do not print: nothing happens when the print cell is selected. 

• Save Sentence: the sentence is saved when the cell is selected. You can 
print the sentence later from the print window by choosing ‘Saved 
sentences’ from the window above. 
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• Print now: the sentence is printed when the cell is selected.  Ensure that the 
correct printer is selected and that you have the settings you want (see next 
section). 

You can print sentences that the user has created and saved either in text or 
symbol mode. 

9.3. Printer setup 

To configure the print options, click on the button marked Print Options in the 
Print window. 

 
The Printer Options window 

Print options 
Select the printer you want to print to from the list.  If your printer is not listed 
then check that it is installed in Windows.  You should also specify the paper size 
and select an orientation for the paper.  Most grids are best printed landscape as 
the screen is wider than it is tall. 

Sentence printing 
This option dictates what will happen when the user selects a print cell.  You can 
choose either to print as soon as the user selects the print cell, or to save the 
sentence and print it later, as described in the previous section. 

Output dimensions 
You may wish to print grids at a specific size for use as a communication aid 
overlay or for storing in achievement records.  The dimensions of some common 
communication aids are listed, or you can manually specify the grid size in 
millimetres.  Ticking the fixed ratio box forces the dimensions to a 4:3 ratio – the 
same as a computer monitor. 

The dimensions of the paper size you have selected are in the print options pane 
on the left.  You should ensure that you do not specify output dimensions that 
exceed the paper size. 
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10. Commands 
There are a large number of commands available to allow control over Windows 
and other Windows programs with The Grid.  These are typed into the 
‘commands’ box, in the advanced part of the Cell Properties window.  Some of 
these are available by clicking on the Commands button. 

10.1. Grid commands 

These commands affect the position of The Grid. 

/output(0) No output 
/output(1) Large symbols 
/output(2) Small symbols 
/output(3) Text 
/output(4) Calculator 
/output(5) Other Windows programs (on-screen keyboard mode) 
/tl Move The Grid to the top left corner of the screen. 
/tr Move The Grid to the top right corner of the screen. 
/bl Move The Grid to the bottom left corner of the screen. 
/br Move The Grid to the bottom right corner of the screen. 
/min Minimise The Grid to show other programs. 

10.2. Shift, control and alt 

/shift Press the shift key. 
/shiftl Lock the shift key. 
/alt Press the alt key. 
/ctrl Press the control key. 

These commands are used to make special cells on an on-screen keyboard.  For 
example, if you create a cell with the command /shift then it will behave as 
follows: 

• Selecting the cell causes it to light up.  The next key selected will be shifted. 

• Selecting the cell again causes it to light up in another colour.  Now all keys 
selected will be shifted until the cell is selected for a third time. 

10.3. Mouse manipulation 

/mmu /mmd 
/mml /mmr 

Move the mouse up, down, left or right. 

/mlmu /mlmd 
/mlml /mlmr 

Move the mouse up, down, left or right by a large step. 

/mlc Left click 
/mrc Right click 
/mdc Double click 
/mdl Drag lock 

Drag lock will hold the mouse button down until selected again.  This allows the 
user to drag objects around the screen, select text and adjust sliders, for example. 
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/ac Toggle auto-click. 
If auto-click is on then dwell clicks will happen automatically.  If not then the only 
place that a dwell click can be performed is an auto-click cell. 

10.4. Windows commands 

/sm Open the Start menu. 
/st Scan through the task list (alt-tab). 

 

The following commands move or resize another program window. 

/dock Dock the current window with The Grid. 
/wmu /wmd 
/wml /wmr 

Move the current window up, down, left or right. 

/wst /wss 
/wsw /wsn 

Make the current window taller, shorter, wider or 
narrower. 

10.5. Miscellaneous commands 

/nudge ‘Nudge’ the cell. 
If you want to repeat an action then you make it a ‘nudge’ cell.  This is useful if 
you want to repeatedly press a key such as an arrow key to move through text or 
menus.  The repeated selection of the cell is handled as an extension of a switch 
scan. 

/sf /ss Scan faster or slower. 
/speaksel Speak a highlighted block of text. 

 

The volume command increases or decreases the volume. 

/vol(+1) Increases the volume. 
/vol(-1) Decreases the volume. 

 

10.6. Advanced commands 

These commands take parameters, or instructions, to provide additional 
information on what they should do. 

The text input box allows you to create a string of characters before sending them 
as a group to the program.  This is useful for entering passwords, web addresses 
and various other tasks. 

/GetText Calls up the text input box. Appears until you select 
the Enter key. 

/PasteText Returns the focus to the current program, and sends 
the contents of the text input box. 
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/wait(100) Wait for the specified time. 
The time is measured in 100ths of a second, so the example here will wait for one 
second. 

/vol(2) Change the volume to level 2. 
/vol(+2) Increase the volume by 2. 

Volume is measured on a scale of 1 (quietest) to 16 (loudest). 

/putmouse(x,y,0) 
/putmouse(x,y,1) 

Put the mouse pointer at position (x,y) on the 
screen. 

If the third parameter is 0 then the pointer will be placed relative to the screen’s 
top left corner.  If it is 1 then the coordinates will be measured from the top left 
corner of the current application window. 

/mscan([x1,y1],[x2,y2]…) Scan the mouse locations (x1,y1), (x2,y2). 
This will move the mouse amongst these locations as an extension of switch 
scanning.  You can enter several pairs of coordinates to scan around a larger 
number of hotspots.  The coordinates specified are relative to where the mouse 
pointer is when the command is called, so you will need to use 
/putmouse(0,0,?) to make sure that the pointer starts in the corner of the 
screen (?=0) or the target window (?=1), as appropriate. 

/keypress(?) 
/keyup(?) 
/keydown(?) 

Control the behaviour of the key with keycode ? 

If you wish to press a key then use the /keypress(?) command, looking up the 
keycode in the table below. 

For more control, you can program a /keydown(?), then some other commands, 
then a /keyup(?).  The Grid does not check to make sure that all pressed keys 
are released, so be careful not to use /keydown(?) without /keyup(?). 

Keycode reference table 
Alphabet keys Number keys Numeric keypad 
65 A 48 0 96 0 
66 B 49 1 97 1 
67 C 50 2 98 2 
68 D 51 3 99 3 
69 E 52 4 100 4 
70 F 53 5 101 5 
71 G 54 6 102 6 
72 H 55 7 103 7 
73 I 56 8 104 8 
74 J 57 9 105 9 
75 K   106 Multiplication Sign (*) 
76 L Function Keys 107 Plus Sign (+) 
77 M 112 F1 108 Enter 
78 N 113 F2 109 Minus Sign (-) 
79 O 114 F3 110 Decimal Point(.) 
80 P 115 F4 111 Division Sign (/) 
81 Q 116 F5   
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82 R 117 F6 33 Page Up 
83 S 118 F7 34 Page Down 
84 T 119 F8 35 End 
85 U 120 F9 36 Home 
86 V 121 F10 37 Left Arrow 
87 W 122 F11 38 Up Arrow 
88 X   39 Right Arrow 
89 Y   40 Down Arrow 
90 Z     

 
Other key codes   
13 Enter 20 Caps Lock 
32 Spacebar 144 Num Lock 
27 Escape 42 Print Screen 
8 Backspace 45 Ins 
9 Tab 46 Del 
    
16 Shift 1 Left Mouse Button. 
17 Ctrl 2 Right Mouse Button. 
18 Alt 4 Middle Mouse Button. 

10.7. Concatenating commands and scripting 

Often it will be useful to use several commands in conjunction with each other.  
For example, to drag the mouse pointer automatically you would need to do the 
following: 

• Turn on drag lock (/mdl). 

• Move the mouse pointer right (/mmr). 

• Release the drag lock (/mdl). 

To do this, simply write the commands one after the other.  In this case, the 
complete command would read: 

 /mdl /mmr /mdl 
If you want to construct a long command to use in several cells, you can create 
this in Notepad, or a similar text editor, with one command on each line.  Then 
save the text file as “mouseDrag.script”, or some appropriate name.  This can then 
be loaded for a cell by click on the Import File button on the commands window. 
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11. Dictionaries 
There are a number of language-specific files used by The Grid, collectively called 
dictionaries.  From the Dictionary Settings window you can see which files are in 
use and change or modify these files. 

 
The Dictionary Settings window 

The Word Bank and Phrase Link Library dictionaries work slightly differently 
from the others.  Rather than specifying one dictionary for use by the current user, 
you select a dictionary for a specific grid.  This could mean, for example, that one 
user may use several different Word Banks on different grids. 

11.1. Prediction 

The prediction file is a list of all the words that can be predicted when typing in 
The Grid.   

 
Editing the prediction list 

Changing dictionary 
The currently selected prediction dictionary is indicated in the box in the 
description bar.  You can change to a different dictionary or create a new 
dictionary from here. 

 45



Removing words 
The list on the left hand side is a list of all the words in the current dictionary.  The 
dictionary can hold 10,000 words, but in practise most people use far fewer words 
in conversation. 

If there is a word that you want to remove from the dictionary (perhaps an 
incorrectly spelt word has been added), select it from the list on the left and click 
on the Remove Word(s) button. 

Adding words 
If you want to add new words to the list you can type (or paste) the text into the 
large box on the right, and then click Add Word(s). 

The prediction system also stores statistics on word pairs and frequency of word 
usage to aid prediction (see section 5.5 to see how to turn these features on). This 
information is updated when you add text, so if you try to add a word that is 
already in the dictionary then it will be promoted in the word usage list.  If you 
have a large body of text written by the user of the program, you can paste it in 
here and click Add Word(s) to teach the prediction system all the word usage and 
word pairs in the text. 

You can also add (or remove) the entire contents of a word bank to the list of 
words in the dictionary by clicking on the Add/Remove Word Bank button. 

 
Adding or removing a Word Bank from the prediction dictionary 

Select the Word Bank you wish to use and click on the Add Entire Word Bank or 
Remove Entire Word Bank buttons.  Information on the Word Bank files is in 
section 11.6. 

11.2. Speech exceptions 

Speech exceptions are words that are not pronounced as they are spelt.  The text-
to-speech engines used with The Grid are very advanced and cope very well with 
pronunciations of most words, but occasionally you may find that a word is 
pronounced incorrectly (or with a very obvious American sound). 

There is another use for speech exceptions that you may find useful, and that is 
spoken abbreviation expansion.  You may, for example, wish the nonsense word 
“mnib” to be spoken as “my name is Barney” to allow fast communication.  This 
is not the same as Abbreviation Expansion (see next section) as the text remains 
unchanged. 
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Edit the Speech Exceptions 

The currently selected exception dictionary is indicated in the box in the 
description bar.  You can change to a different dictionary or create a new 
dictionary from here. 

Type the word as it is spelt on the left, and as it is to be pronounced on the right, 
and test the new pronunciation with the Test button.  When you are happy with the 
new pronunciation, click on the Add button. 

To remove an exception, click on the remove button. 

11.3. Abbreviations 

The abbreviation dictionary is a list of abbreviations and corrections that are 
applied to text automatically as it is typed. 

Examples of use for abbreviation expansion: 

mn → my name 

ch4 → channel 4 

Examples of use for corrections: 

recieve → receive 

cafe → café 
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Edit the Abbreviation Expansion dictionary 

The currently selected abbreviation dictionary is indicated in the box in the 
description bar.  You can change to a different dictionary or create a new 
dictionary from here. 

Type the word to be changed on the left, and the new word on the right, and click 
on the Add button. 

To remove an abbreviation, click on the remove button. 

11.4. Capitalisation 

There are a number of words that are always written with a capital letter, such as 
the names of people and places.  In order to avoid having to select Shift before 
these words you can create a list of words with capital letters in.  Each time one of 
these words is typed it will be capitalised as it is in this list. 

 
The Capitalisation dictionary 

The currently selected capitalisation dictionary is indicated in the box in the 
description bar.  You can change to a different dictionary or create a new 
dictionary from here. 
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Each word or phrase in the list should be on a separate line.  For example, a phrase 
such as “Great Western Railway” may have each of the words “great”, “western” 
and “railway” capitalised automatically. 

11.5. AutoFind pictures 

When editing a cell you can use the AutoFind dictionary to choose a picture based 
upon what you type.  This is particularly useful for creating symbol grids, a task 
that can be time consuming and for which you want consistency of symbols 
between grids. 

 
Editing the AutoFind dictionary 

If you have purchased a symbol set such as the PCS or Rebus symbols then there 
should be an AutoFind dictionary available.  Select it from the list, or contact your 
software dealer if it is not there in your language. 

Once you have selected a dictionary, you need to specify the location of the files 
on your computer.  Click on the Set Location of Pictures… button, and select the 
folder that the pictures are in.  This will usually be: 

 C:\Program Files\Sensory Software\Common\Pictures\SET NAME\ 
where SET NAME is the name of the picture set. 

If you installed your symbol library with another program such as Writing with 
Symbols or BoardMaker, you may find the pictures in a different location on your 
hard disk. 

Editing the list 
To see the picture currently selected for a word, find the word in the list on the left 
and click on it.  A word can have more than one picture assigned to it. 
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If the word does not have the association you want then choose the picture from 
the file list on the right, and click on the Add… button.  Type in the word to be 
associated with this picture and click Ok. 

If you wish to remove a word from the list then select it from the list on the left 
and click on the Remove button. 

11.6. Word banks 

Word banks are simply lists of words that are added to a grid automatically after 
selecting the first letter. 

When a grid has BOTH a word bank and prediction, the word bank is used after 
the first letter and the full prediction dictionary is used after subsequent letters. 

 
Editing a word bank 

The Word Bank window allows you to create and edit word banks.  Select the 
word bank that you wish to edit from the drop down list.  If you select New, you 
will be prompted to give it a name. 

All you now need to do is to edit the list of words.  Note that The Grid will load 
the words into a grid in the order in which they occur in the file.  

Remember that the words in a word bank can be added to your main prediction 
dictionary if you wish.  This means that word banks can be kept as a resource for 
building topic sensitive prediction files, even if they are never used directly by a 
grid. 

11.7. Phrase link library 

Phrase linking is a way of making two or three cells, selected in sequence, give a 
different word.  

Note that phrase linking works only in a text bar or when sending to another 
Windows program.  To use it, you must choose a phrase link library file for the 
grid you are using (see section 3.2). 
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Editing a Phrase Link Library 

When you first call up the Phrase Link Edit window, it will show you the words in 
the cells of the current grid, and the phrase link library used with that grid. 

The principle is very simple: when you select a series of cells that have a link 
word or phrase, the program will substitute that word or phrase. 

For example, if you have a line in the phrase link library that says  

future she go = she will go 
Then selecting the three cells “future”, “she” and “go” in that order will type “she 
will go” rather than “future she go”.   

Power memory = elephant 
This is the same technique used in semantic compaction systems to get a large 
vocabulary from a single overlay, such as the example above. 

 nice nice = great 
You can also create emphasis by selecting the same cell repeatedly – so twice as 
nice means great. 

Creating the links is easy.  Click on the cells in turn and they will be added to the 
current line in the phrase link library.  After the = sign, type in what you want to 
be typed when that sequence is selected, and click the Add Link button.  You can 
edit the link manually, or press Clear if you go wrong.  You can see the links in 
the current library by clicking on the arrow on the right side of the text box, and 
links can be removed from the library by selecting them and clicking on the 
Remove Link button. 

Phrase link libraries may also be edited in a plain text editor like notepad if you 
prefer. 
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12. Environment Control 
The Grid may also be used to operate your environment control system.  The 
instructions here assume that you have a GEWA Prog controller connected to your 
computer.  If you have a different controller, or if you are not sure what you have, 
then you should contact your supplier for guidance. 

The principle is very simple.   The Prog (or other controller) learns the codes that 
are sent by other remote controls, like the one on your TV, and sends these codes 
under the control of The Grid. 

Once your controller has been trained to work with different devices around the 
house, it is very quick to select the action for the controller, just like any other 
command.  These instructions assume that your controller has not been trained. 

12.1. The Environment control window 

Right click on the cell and click the Advanced Options button and then the 
Environment Control button. 

 
The Environment Control window 

The commands are arranged in ten groups (called levels), each of which contains 
sixteen functions.  Each level also contains an ‘emergency call’ function that is the 
same in each level.  This is initially denoted by an ‘!’ mark. 

Find the command you wish to use and select it, and then click on Ok. 

12.2. Renaming the commands 

You can rename both the levels and the commands within the levels.  For 
example, you may wish to rename Level 1 as ‘Television’, and rename the 
commands as ‘Channel 1’, ‘Channel 2’, ‘On Off’ and so on. 
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Click on the level or command you want to rename to select it.  Wait a moment 
and then click on it again, and type in the new name.  Press enter or click 
elsewhere when you have entered the name. 

Note: The two clicks are slower than a double click – you click once to select it, 
and again to put the cursor there to type the new name. 

Normally, you would use the level names to describe a device (like TV) and the 
functions for controls on that device (like Volume Up).  However, you are free to 
use any function in any level to control anything you like. 

12.3. Train the commands 

If you want to teach the GEWA Prog a new command, select the command you 
wish to record, and click on the Record button. 

Now aim the original controller (for example the TV controller) at the Prog and 
press (and hold) the desired button.  After a couple of seconds, the program will 
ask you to make a second press to confirm that it is trained correctly. 

You may now test the control by clicking the Test button. 

Note that the last command in each level is the Emergency function.  If it is 
retrained in one level, it will change in all levels. 

12.4. Continuous controls 

Some controls, like opening a window or raising the volume of the TV require the 
command to be transmitted continuously from the controller until the desired level 
is reached.   To repeat the infrared transmission under the control of your 
switches, tick the ‘Nudge this command’ box when selecting the command to 
transmit. 

12.5. Selecting a function for a cell 

Once the controller is trained, and the functions have been labelled to match the 
devices that will be controlled, assigning a control function to a cell is very 
simple. 

Right click the cell and open Advanced Options.  Then click the Environment 
Control button and select the function you want. 
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13. Care of your files 

13.1. Backup and restore your grids 

Any computer file is at risk from corruption, accidental deletion or even the 
complete failure of your hard disk drive.  The ONLY safe way to ensure that you 
do not lose files is to back them up. 

Re-installing The Grid is easy, and can be done from the CD.  Re-creating the user 
settings will also be fairly easy.  The most important thing to back up is your grid 
sets, as these may represent a great deal of work. 

As well as making a secure backup, it is useful to be able to share grids between 
users. 

Backup or export of grids 
Select File > Export > Grids from the menu. 

 
Exporting grids to another folder 

On the left, there is a list of the grids in the current grid set.  Select the grids that 
you wish to export. 

On the right, there is a list of the disk drives available on your system.  Use the list 
to select the place to which you wish to export the grid(s).  If you wish to place a 
few grids onto a floppy disk, just click on A:  If you are backing up to another 
hard disk, you will need to select the folder as well as the drive letter. 

Click the Export Grids button to copy the grids. 

Export to Pocket Grid 
Note: if you are using Winspeak CE or Pocket Winspeak, you should use the 
software supplied with it for exporting grids. 
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To export all or part of a grid set to a Windows CE computer running Pocket Grid 
you need to have your memory card in your card reader. 

With the memory card in place, select File > Export > Pocket Grids from the 
menu. 

 
Exporting Pocket Grids for use on a Windows CE computer 

Choose the drive letter that Windows has assigned to your card reader from the 
selection in the top right.  The Grid will remember this letter, so you should not 
need to select it again. 

You should also specify the resolution of the device you are using.  Note that grids 
are transposed for export to a 240x320 device due to the shape of their screens. 

If you tick the ‘Display Pocket Grids on PC’, you will be able to view and edit the 
grids, seeing them exactly as they will appear on your CE device.  It is worth 
checking that the text in the cells is visible and that the pictures are clear enough 
when reduced in size, and if you are exporting to a 240x320 resolution you can see 
the results of the transposition.  You can specify the font used for the pocket grids 
by clicking on the ‘Set Font…’ button. 

On the left is a list of grids in the current set, with a tick next to those that are 
present on the card.  If you wish to add another grid to the card then tick the box 
next to it, and to remove one then remove the tick.  When you have the grids you 
want selected, click on ‘Export Grids’ to add/remove grids from the card as 
necessary. 

Import or restore grids 
Select File > Import > Grids from the menu. 
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Importing grids from another folder 

If you are importing a grid from another grid set on the same computer, select the 
grid set from which you wish to import a grid from the list on the left.  If you are 
restoring from another disk, move up or down this list to find the letter for the 
drive that contains your backup. 

The list on the right shows a list of grids that are available to import.  Select the 
grids that you wish to import. 

Click the Import Grids Button to import them into the current grid set. 

13.2. Grid files and grid sets 

If you are reasonably familiar with using Windows, you can use Windows 
Explorer to move grids from one set to another (or from one computer to another).  
The layout of the files is as follows: 

Grids are stored in Program Files\Sensory Software\Common\Grid Sets.  

In this folder is another folder for each grid set.  When you first install The Grid, a 
grid set called English (UK) Sample is created.  Installing additional vocabularies 
will create additional grid sets.  You may also have created some yourself. 

The Grid set folder contains a separate folder for each grid.  It contains any 
pictures or sound files used in that grid, along with an index file. 

Grids may be copied as complete folders from one grid set to another, or to a 
backup device, or to another machine across a network. 

The grid set folder may also contain a set of pictures that are used as default for 
certain actions and a file that tells the program which grid to start with when using 
that grid set. 
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13.3. Language files 

Many of the files in The Grid are language specific, and these are all kept in a 
folder called Program Files\Sensory Software\Common\Language. 

We do not recommend altering these files manually, but it is a good idea to back 
them up.   

File type Purpose 

.CLX and .TLX  Spell checker dictionary 

.WDS and .DTA  Prediction dictionary 

.BNK  Word banks 

.CAP  Auto capitalise 

.LEX  Speech exceptions 

.ABR  Abbreviation expansion and auto correction 

.PIX Picture index 

.PLL Phrase link library 

.PMT The text of menus and dialogue boxes 

PRINTER.TXT Devices for overlay printing 

13.4. Uninstalling 

To uninstall the program, select Programs > Sensory Software from the Start 
Menu.  You will see an icon for uninstalling Sensory Software.  

The first window allows you to select the language to use for the uninstaller. 

The second window allows you to select which programs you wish to uninstall.  If 
you select ALL the programs, you may also select the option to remove the 
support files as well.  Otherwise, they will be left on your hard disk. 

This will clear your disk space, but the Sensory Software folder will remain in 
Program Files unless you delete it manually. 

To remove the program icons from the Start Menu, right click on Start and select 
Open.  Double click on Programs > Sensory Software.   You may then delete 
any icons that you no longer require.  If you have uninstalled all Sensory Software 
programs, you may also delete the Sensory Software program group. 

If you have placed a copy of the Program icon in the Startup group, you will also 
need to remove it from there. 
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14. Tips for using The Grid effectively 

14.1. Shortcut keys for The Grid 

To enable a helper to assist someone using The Grid, there are some shortcut keys: 

Ctrl-Alt-PageUp Go back to the previous page. 

Ctrl-Alt-Home Return to the start page for this grid set. 

Ctrl-Alt-E  Edit the current cell (same as right click). 

Ctrl-Alt-P  Save a bitmap of the current grid. 

14.2. Launching The Grid automatically at startup 

To make a program launch when the computer is turned on, you need to add a 
shortcut for that program to the Startup group on the Start Menu. 

The easiest way to do this is to right click on the start button and choose Open.  
Find the Programs\Sensory Software folder and select the icon for The Grid.  
Choose Edit > Copy from the menu, and then go back to Programs\Startup and 
choose Edit > Paste from the menu. 

14.3. Hiding the Windows Taskbar 

Access to the Windows taskbar allows you to launch programs, turn off the 
computer and access other Windows features.  Often, you will not want the user to 
be able to do these things. 

There are two Windows options that are useful here.  You can use ‘Auto-hide’ to 
hide the taskbar when not in use, and you can stop the taskbar appearing on top of 
other programs, allowing them to fill the screen. 

If you have hidden the taskbar, pressing the Windows key on your keyboard will 
bring up the start menu at any time. 

To see the taskbar properties, select ‘Taskbar and Start Menu’ from the 
‘Appearance and Themes’ section of the control panel, or right-click on the Task 
Bar and choose Properties. 
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Taskbar and Start Menu Properties 

For total security, set BOTH “Keep the taskbar on top of other windows” and 
“Auto-hide the taskbar” to OFF.  The taskbar will be unavailable and the user will 
need to have a keyboard connected in order to switch to other programs or turn off 
the computer. 

To allow the user to run other programs, set “Keep the taskbar on top of other 
windows” to ON and “Auto-hide” to OFF.  The Grid will use the whole screen, 
except for the task bar. 

For switch users, set BOTH of these settings to ON.  The taskbar will not be 
normally be visible, but by moving the mouse to the very edge of the screen the 
taskbar will re-appear, allowing other programs to be accessed easily by a helper.  

14.4. Displaying the keyboard shortcuts 

In versions of Windows prior to Windows XP, keyboard shortcuts are underlined 
on menus and buttons. 

By default, Windows XP will hide the underline until the Alt key is pressed.  To 
display these all the time, select ‘Display’ from the ‘Appearance and Themes’ 
section of Control Panel, or right click on the desktop and choose properties. 

Choose the Appearance tab of the Display Properties window, and click on the 
Effects… button. 
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The Appearance tab of Display Properties and the Effects window 

Make sure that the box marked ‘Hide underlined letters for keyboard navigation 
until I press the Alt key’ is not ticked. 

14.5. Reducing screen flicker 

If you find that the screen flickers whilst using The Grid, try turning off rounded 
corners in the Appearance settings.  See section 5.2 for more information about the 
Appearance settings. 
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